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GIS Lab #3: Map Projection and Coordinate Systems 
Thanks to Mark Helper of Texas University and to Joseph Kerski of USGS 

 

Objectives 

 Gain experience in ArcMap using on-the-fly-projection of various common 
projections  

 Learn how to define a projection in ArcCatalog and ArcToolbox  

 Learn how to project vector data using ArcToolbox  

 Learn how to register imagery and CAD files 

 

Introduction and Summary 

Recall from lecture that maps are, in essence, graphs and that creating maps with a 
computer is analogous to plotting points and lines on graph paper.  For software to 
show the geographic location of features, the features must be stored with x and y 
coordinates tied to a specific origin (i.e. X=0, Y=0; a "Coordinate System") and a 
datum.  The datum specifies the dimensions of a model of the earth; the length of the 
minor and major semi-axes of an ellipsoidal earth or the radius of a spheroidal (see 
lecture notes).  Together, the datum and coordinate system comprise the so-called 

"Spatial Reference" of a data set. 

In ESRI lingo, Spatial References are of two types: 

1. A Projected Coordinate System ("PCS"), is composed of a datum (e.g. 
WGS84) and coordinate system parameters (e.g. location of origin and 
standard parallel(s) in lat. & long., type of developable surface, false easting 
and northing, etc.; see lecture notes) specific to a map projection.  PCS 

coordinates of features are stored in meters or feet relative to the PCS origin. 

 

2. A Geographic Coordinate System ("GCS"), includes only a datum, location of 
a Prime Meridian (Y-axis; the X-axis is always the equator), and an angular 
unit of measure.  A GCS has units of decimal degrees - GCS coordinates of 
features are stored in degrees of latitude and longitude.  West longitudes and 
South latitudes are stored as negative values and the units are decimal 

degrees (DD), not Degrees, Minutes and Seconds (DMS). 

One of the principal, traditional strengths of GIS software is the ability to convert data 
stored in one Spatial Reference to another Spatial Reference.  This map projection 
process may involve conversion of coordinates from one GCS to another GCS, from 
a GSC to a PCS, or from one PCS to another PCS.  A computer screen or paper 
map can only have one Spatial Reference; one origin and one set of axes for the 
graph.  Thus, the ability to convert coordinates from one Spatial Reference to 
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another is a key aspect if one wishes to simultaneously view data sets that have 

different Spatial References. 

Within ArcGIS, ArcToolbox has tools to do these conversions.  In so doing, you can 
create a new, permanent data file containing coordinates in the new Spatial 
Reference. Alternatively, temporary ("on-the-fly") conversion to a different Spatial 
Reference is done automatically upon adding data in ArcMap.  This on-the-fly 
conversion permits viewing of data sets that have different Spatial References 

without first having to create a new file(s) of converted coordinates with ArcToolbox. 

For either of these processes to work the software must first know the Spatial 
Reference of the dataset(s).  If this information is missing from a dataset, then 
ArcToolbox and ArcCatalog have tools for creating it, a necessary first step (called 
"Defining a Spatial Reference" or "Defining a Projection") before permanent or on-
the-fly conversion can be successful.  Many older data sets are missing Spatial 
Reference information and can produce problems if this "defining" step is ignored.  
Worse still are datasets with the wrong Spatial Reference definition!  We will learn to 

recognize datasets with these shortcomings and to apply appropriate fixes. 

 

Data Management  

Create a folder for this exercise and name it Lab03_projection. As you know, it is 

best to name the folder without any spaces in the name.  

You now should have 15 files with the following names:  
mn.tif   
states.dbf  
states.prj states.sbn  
states.sbx  
states.shp  
states.shx 
states.sbx  
stfrancisfire.jpg  
toddroads.dbf  
toddroads.shp  
toddroads.shx  
toddhydro.dbf  
toddhydro.shp  
toddhydro.shx  
counties.dwg 

 

Start ArcGIS with a blank map document.  

Add the following layers:  
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states  

mn.tif  

Rename your data frame as "Minnesota"  

1) Based on the main theme of this lesson, why do you suppose that at this point, the 
Minnesota image does not overlay on top of the boundaries for Minnesota?  

 

2) Where does the Minnesota image lie in relation to the state outlines?  

 

3) What coordinates do you observe for the northwest corner of the Minnesota 

image?  

 

4) What are the coordinates for the northwest corner of Minnesota on the state 

outline layer?  

 

5) What does ArcGIS do when no registration information exists for a layer?  

 

You will create header information so you can register the image.  

Save your map document as imageregistration and give it an appropriate name, 
placing it into your Lab03_projection folder.  

Typical images used in GIS and remote sensing analysis are in .bil, .tif, .jpg, and .bip 
formats. The file extension for a header file is usually the first and last letters of the 
image file extension, with a “w” at the end for “world” file. For example, the header for 

mn.tif  should be mn.tfw.  

* Sometimes, image registration information is embedded inside the image itself. For 
example, geotiff image files do not have a separate header. Programs do exist that 
can pull out the header information into a separate file if the user needs it for any 

reason.  However, all GIS software will read geotiffs and correctly place the image.  

6) Enter the world file name for the following files under the column “world file name.”   
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image file name   world file name 

sheboygan.jpg   

rosebud.tif  

southdakota.bil   

* Sometimes, image files have header files that are a different format than that 
discussed here. For example, some tif files will have a .hdr header.  

 

Understanding Registration and World Files  

A world (registration) file for an image is just a text file consisting of six lines. Here is 
a simple example, below. The simplest situation to describe is one using decimal 
degree (or “geographic projection”) data:  

0.0107   
0.0  
0.0  
-0.0087  
-97.26  
49.43  

If the image is formatted in something like an Albers projection instead of decimal 
degree, it is still possible to create an effective world file; it just takes a little more 
tinkering.  

Note: Creating a header file for a “projected image” involves basically the same 
process and header, except that the top left coordinates will be in numbers of meters 
away from a projection reference. Here  is an example of a world file for an image in 

Albers projection:  

4100.0  
2.51179777165858  
-0.08833980138674  
-4050.0  
-2360630.88315064972267  
3182746.43488585297018  

Each line in a registration file has a special purpose. The lines are not 
interchangeable, and must always be presented in this order, so writing a correct 

world file requires understanding the purpose and the data.  

LINE1 =  how much of a map unit (in this case, degrees) is represented by moving 
one pixel eastward from any spot (positive number).  
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LINE2 =  how much the  image should be skewed from the sides (negative number, 

 but usually zero)  

LINE3 =  how much the  image should be skewed from top and bottom (positive 

 number, but usually zero)  

LINE4 = how much of a map unit (in this case, degrees) is represented by moving  

 one pixel southward from any spot (negative number)  

LINE5 =  X coordinate  (in this case, decimal degrees  longitude) of the top 
left (northwest) corner of the image (decimal degrees means negative 

number for 0-180 west, positive number for 0-180 east).  

LINE6 =  Y coordinate  (in this case, decimal degrees  latitude) of the top left 
(northwest) corner of the  image (decimal degrees means negative 

number for 0-90 south, positive number for 0-90 north).  

7) In the example header file above, is the image skewed?  

8) In the example header file above, what is the latitude-longitude coordinate of the 
northwest corner of the image?  

9) How many degrees are represented by moving any number of pixels in the E-W 

direction?  

10) How many degrees are represented by moving any number of pixels in the N-S 

direction?  

 

Creating a World File and Registering an Image  

Minimize ArcGIS.  

Engage a graphics program such as Photo Editor under "Microsoft Office Tools" or 
another graphics program. Open the image “mn.tif”. This is a Minnesota colorized 
image file based on a digital elevation model (DEM), with the different colors 

representing elevation.  

Look in the lower right under “W” and “H” for the width and height of the image. If you 

are using Windows Paint, access “image” and then “attributes” for this information.  

11) Enter width in pixels:  ________________  

12) Enter height in pixels:  ________________  

Access ArcGIS again.  
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Add Data and navigate to the location of your data for this lesson.  

Access symbology for the states file. Make the states transparent and symbolize the 
state  boundaries with a 2 or 3 thickness.  

Scroll the mouse across the state outlines.  

Zoom to the extent of Minnesota’s image.  

Determine the latitude and longitude coordinates for the top left and bottom right 
corners of  the image, using decimal equivalents for easy fractions (1/3 = .33 and so 

on).  

Fill in the following “worksheet,” substituting known numbers.  

Assume that you do not want any skew.  

Line 1 is the longitude of the SE corner minus longitude of NW corner) divided by 

image width in pixels.  Show your work.  

13) LINE1 = _____________  

14) LINE2 = ___________  

15) LINE3 = ___________  

Line 4 is the latitude of the SE corner minus latitude of NW corner) divided by the 
image height in pixels. Show your work.  

16) LINE4 = ______________  

Line 5 is the northwest corner longitude.  

17) LINE5 = ______________  

Line 6 is the northwest corner latitude.  

18) LINE6 = ______________  

Examine the image below. When recording the NW and SE corners, use the 
locations of the + plus signs shown in this image, so you account for Minnesota’s full 
extent. Don’t cut off the Lake of the Woods area or the northeast corner of the state 

along Lake Superior.  

Note that Lines 4 and 5 have to be negative numbers.  

19) Why does line 5 have to be negative?  
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Create the world file with your data above and name it mn.tfw. Create it in WordPad 
or NotePad. You may use a Word Processor, but make sure you save it in text file 

format.  

Note that the header file must have the format (you will substitute your values, 

above):  

0.01072  
0.0  
0.0  
-0.0087  
-105.10903  
39.40582  

Remove the mn.tif layer. Add the layer again after you create the header file. 
Remember to move your state outlines ABOVE your image and make the fill 

transparent as a guide in your registration.  

20) Does the Minnesota image now overlay on top of your state outlines?  

If the two layers are CLOSE, but do not exactly overlay, continue adjusting the 
header file, removing it and re-adding it to your ArcMap session until you are 
satisfied with the registration. Images may be offset from the vector data, depending 
on the accuracy of the image, the vector data used, and the coordinates you decided 
on. You can create an approximately correct world file through this method, but you 
may have to refine this file once you see how the image lines up with other known 
data sets. Each time you change and re-save the world file in your text editor, you 
must then delete and re-add the image in ArcGIS to test it. To do this in ArcGIS, 
remove layer. ArcGIS remembers the registration information for an image when it is 
first brought into a view, so changes to the world file will not re-position the image 

until the image is added again.  

When refining the world file, first ensure the accuracy of Lines 5 and 6. Once this 
“starting point” is properly set, you can then tweak Lines 1 and 4 to stretch or shrink 
the image. Add a little bit at a time to the numbers in Lines 1 and 4 to expand an 

image; subtract from the numbers in Lines 1 and 4 to shrink an image.  

21) What coordinate system have you registered your image to?  

22) Name a few problems with the method you just used, considering data quality 

issues and GIS user issues.  

23) Create a layout that includes the state outlines and your image, along with any 
other pertinent information that you consider to be appropriate. Zoom the extent to 
Minnesota and portions of the adjacent states and provinces. Print this and attach it 

to these lesson sheets.  

Once you’ve done the best you can do with adjusting the image, do the following:  
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24) Write the contents of your final header file below:  

Save your ArcGIS map document again.  

 

Image Registration Using Georeferencing Tool in ArcMap  

In this section, you will use the Georeferencing Tool in ArcMap to register your 
image.  

Start a new ArcMap session.  

It is important to start working with an unregistered mn.tif image. If you registered 

your mn.tif above and have a mn.tfw file, the easiest thing to do to “disconnect” the 

registration information from your image is to rename mn.tif to minnesota.tif.  

25) Why does renaming “disconnect” the image registration information from the 

image itself?  

Add minnesota.tif to your data frame.  

Add states.shp to the data frame and change the symbology to hollow. Increase the 
outline width to 2.  

Your minnesota image file should once again be sitting down at 0 latitude, 0 

longitude.  

26) Why is the image at 0 latitude 0 longitude?  

 

View toolbars and access the georeferencing tool.  

The general steps for georeferencing a raster using the georeferencing tool are:  

1. Add to your map the raster and the vector layers (target data) to which you want to 

align the raster.  

2. Add control points that link known raster positions to known target data positions 

in map coordinates.  

3. When you're satisfied with the registration, save the georeferencing information 
with the raster.  

For most rasters, the georeferencing information is stored in a separate file with the 
same name as the raster but with an .aux file extension. You can permanently 
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transform the raster by using the Rectify command on the georeferencing toolbar. 
The coordinate system assigned to the raster is the same as the coordinate system 

defined on the data frame the raster is part of.  

Zoom in on the state of Minnesota on the states outline map.  

From the Georeferencing toolbar, click the Layer dropdown arrow and click the raster 

layer you want to georeference.  

Click Georeferencing and click Fit to Display. This will display the raster in the same 
area as the target layers. You can also use the Shift and Rotate tools to move the 

raster as needed. The view frame should look similar to that below:  

 

Click the Control Points button to add control points. The button looks like 2 crosses 

with a line joining them:  

 

To add a link, click the mouse pointer over a known location on the raster, then over 
a known location on the state line (target) data. You may find it useful to zoom in to 

add your links.  

Add enough links for the transformation order. You need a minimum of six links for a 
second order transformation—that means 12 clicks of the mouse.  

Try to select points that are easily identifiable on each data set, and points that are 
scattered throughout the data sets for the best registration, such as the corners of 
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the state. Also, select points that are on all major corners of the state, not just one 
side. If the image becomes skewed beyond recovery, it is best to delete the data sets 

from the view frame and start your session over.  

Remember that you are drawing links FROM the raster TO the vector (state lines) 

files.  

27) Why is your destination the vector file?  

For example, to register the southeast corner of the image to the southeast corner of 
the state lines file, you would click on the southeast corner of the image FIRST, then 

the southeast corner of the state lines, as follows:  

 

Click View Link Table to evaluate the transformation. You can examine the residual 
error for each link and the RMS (Root Mean Square) error. If any of the errors is 

much higher than the rest, you can delete that row in the table.  

28) What is your total residual error?  

 

When you are satisfied with the registration, you can stop entering links.  

Click Georeferencing and click Update Georeferencing to save the transformation 
information with the raster. This creates a new file with the same name as the raster 

but with an .aux file extension.  

29) Using Windows Explorer, browse to your folder and answer the following 

question: What new file(s) were just created by the georeferencing method?  
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Save your map document.  

 

 

Registering CAD file 

Activate “Minnesota" data frame   

Add counties.dwg to your data frame. 

Create (manually) a world file to register the CAD file 

The world file structure 

A world file is a text file (.wld) containing one or four pairs of x,y coordinates. The first 
pair of coordinates is the x,y location of any known control point in your drawing file. The 
second pair of x,y coordinates is a new location in geographic space where you want the 
CAD drawing control point to be in ArcMap. These coordinates comprise the first point of 
the two-point transformation. The remaining pairs of coordinates follow the same 
structure as the first and second pairs. They make up the second point of the two-point 
transformation.  
The world file format is as follows:  
 

x,y location in CAD drawing space {x,y location in geographic space} 

<From X1,From Y1>  <To X1,To Y1> 

<From X2,From Y2>  <To X2,To Y2> 

The world file must have the .wld extension and cannot have more than two lines in 
the above format 

Using the Shift tool 

1. Click the Shift button on the Georeferencing toolbar.  
2. Click the mouse button.  
3. While holding down the mouse button, drag the CAD layer to the desired 

location.  

4. Once you've finished positioning the CAD layer, release the mouse button.  

The CAD layer will appear at the location you specified. 

Using the Rotate tool 

1. Click the Rotate button on the Georeferencing toolbar.  
2. Click the mouse button.  
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3. While holding down the mouse button, rotate the CAD layer to the desired 
orientation.  

4. Once you've finished rotating the CAD layer, release the mouse button.  

The CAD layer will appear at the orientation you specified. 

Using the Scale tool 

1. Click the Scale button on the Georeferencing toolbar.  
2. Click the mouse button.  
3. While holding down the mouse button, scale the CAD layer to the desired size by 

dragging the pointer up or down.  

4. Once you've finished scaling the CAD layer, release the mouse button.  

The CAD layer will be the size you specified. 

Creating control points 

1. Click the Add Control Points button on the Georeferencing toolbar.  
2. Click the mouse pointer on the known location in the CAD layer to create the 

from point.  
3. Click the mouse pointer on the known location on the map or reference layer to 

create the from point.  

The control point will appear on the map. 

Entering specific x,y map coordinates 

1. Click the Add Control Points button on the Georeferencing toolbar.  
2. Click the mouse pointer on the known location in the CAD layer to create the 

from point.  

3. Right-click and click Input X and Y.  

The Enter Coordinates dialog box appears.  

4. Type a x-coordinate value.  
5. Type a y-coordinate value.  

6. Click OK.  

The control point will appear on the map with its destination coordinates defined by 

the values that were typed on the Enter Coordinates dialog box. 
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Project a shapefile 

You may frequently have datasets representing the same location that are already 
stored in different projections and coordinate systems. At ArcGIS, there is a Projection 
Engine that allows you to convert datasets from one projection to another. In this 

exercise, you will project one dataset to match another. 

1. The 6 shapefiles needed for the exercise, roads_utm27, roads_sps83, 
stands_utm83, and stands_sps27. The files will be placed in separate 
directories (utm and state_plane) on your removable drive. 

 
Here are the projection parameters for each dataset: 

name data projection zone datum units 

soils_spn27 forest soils 
State 
Plane 

WA-
North 

NAD27 feet 

nwi_spn83 
National Wetland 
Inventory 

State 
Plane 

WA-
North 

NAD83 feet 

streams_sps83 streams 
State 
Plane 

WA-
South 

NAD83 feet 

pls_sec_sps27 PLSS sections 
State 
Plane 

WA-
South 

NAD27 feet 

roads_utm27 roads UTM 10 NAD27 meters 

soils_utm83 soils UTM 10 NAD83 meters 

2. Insert a new data frame (Insert > Data Frame), and alter its title to State Plane.  

3. Add all 4 of the State Plane datasets (from the State Plane directory) from the 
file you downloaded and extracted. If you get an error message, click OK. This is 

because none of the shapefiles have projection information stored with them. 
 
 
Even though these datasets represent features at the same real-world location, 
the projections they are stored in differ, which is why they do not overlap as 
expected. Although all 4 of these are stored in the State Plane system, they differ 
in both the State Plane zone and the datum in which they are stored . These 
differences are what cause the layers not to line up with each other.  

4. Create another data frame (call this one UTM) and add both shapefiles from the 
UTM directory to the data frame. 

 
If you zoom in and pan around, you will see clearly where the layers do not line 
up where they should. 
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The difference between NAD27 and NAD83 is less profound when using the 
UTM system than when using State Plane for Washington State, but you should 
still be able to see how the features do not line up as expected. 
 
We will project the roads dataset so it will overlay the stands correctly. 

5. Because neither of these datasets have projections defined, the first step will be 
to define the projection on each of them. Note that "defining" the projection on a 
dataset does not alter the dataset in any fundamental way, it just makes a record 
of what projection the dataset is stored in. However, in order for ArcGIS to project 
a dataset from one system to another, it must know what the input projection 
system is. This step, defining the projection, accomplishes the task of letting 
ArcGIS know about the dataset's current storage parameters. It is absolutely 
essential that you define a dataset's projection properly. If you make a mistake in 
defining the projection, errors will ensue any time you use the dataset. 

6. Open ArcToolbox. You may want to "dock" it in your application window.  

7. Select Data Management Tools > Projections and Transformations and 
double-click the Define Projection tool. 

1. Select roads_utm27 as the Input Dataset.  

2. Click the button to select a coordinate system .  
3. Click Select. Select Projected Coordinate Systems > UTM > NAD 1927 

> NAD 1927 UTM Zone 10N.prj. A progress window will display. When 
the process is complete, Close the dialog. 

4. Don't skip this step! Do the same for the stands_utm83 layer, but 
select the projection Projected Coordinate Systems > UTM > NAD 
1983 > NAD 1983 UTM Zone 10N.prj  

8. From ArcToolbox, now select the tool Data Management Tools > Projections 
and Transformations > Feature > Project. 

1. Select roads_utm27 as the Input Dataset. For the Output Dataset, 
specify that you will be saving the dataset as roads_utm83. 

2. For the Output Coordinate System, click the button to select a 

coordinate system . Click Import, which will allow you to copy the 
coordinate system from an existing data source. Navigate to the dataset 
for stands_utm83. 

3. For the Geographic Transformation, select 
NAD_1927_To_NAD_1983_NADCON. 

9. Click OK. A progress dialog will indicate when the process is complete. Click 
Close. 
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10. The new dataset is added as a layer to the map. Turn off the roads_utm27 layer 
and turn on the new roads_utm83 layer. You will see that it now overlaps with 

the stands properly. 
 
You have just projected a layer from one projection to another. Use this 
technique whenever you have datasets that are stored with incompatible 
projections. In order to be able to project datasets, you will need to know both the 
input and output projections.  

  

 


